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Microsoft Access 2003  
 

Using More Than One Table 
Typically, a database will have more than one table. For example, in a 
registration system, one table might contain information about each individual 
student, and another table might hold information about which classes each 
student has enrolled in. In order for Access to be able to assemble the 
information from these two tables, a relationship has to be established between 
the two tables. One type of relationship is the “one to many” relationship, which is 
illustrated here. 
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Creating a Relationship Between Tables 
To Create a Relationship Between Tables: 

1) Click the Tools menu item, then select Relationships. Or, click the 
Relationships icon in the toolbar 

 
 

2) If the Show Table dialog box doesn’t appear in front of the gray 
Relationships window, click the Show Table icon. Relationships screen 
with Show Table box will be displayed.  

3) Double-click each table you’d like to include in the relationship. 
Alternatively, 

4) Select a table you’d like to include, then click the Add button. This will 
place representative field lists on the Relationships window, as shown next. 
Field lists for tables in the Relationships window 

5) Left-click and hold the mouse button on the field name you want to relate to 
a field in another table. Below, Social Security # is the field that will relate 
one table to the other. Click and hold the Primary Key in the parent table 

6) Drag the mouse from the Primary Key in the first table towards the related 
field in the second table (the Foreign Key).  

 
 



 3

7) Release the mouse button to display the Edit Relationships dialog box 
8) Click in the Enforce Referential Integrity check box 
9) Click the Create button. The relationships window will show a line between 

the related fields as shown on the next page. On one end of the line is a “1” 
indicating the “one” side of a one-to-many relationship. 

10) The other end of the line will have an infinity symbol next to it to show that 
there are potentially many entries on the “many” side of the one-to-many 
relationship. 

 

Relationship diagram showing “one to many” relationship (one student, 
many classes). 

 
 
 

11) Click the Save button to save the relationship 
 

Referential Integrity 
The “one” side of a relationship is represented by a table which is considered the 
“parent” table. A primary key in this table is called the Primary Key. The “many” 
side of the relationship is considered to be the “child” table (a parent can have 
many children). A primary key in this table, if a one-to-many relationship exists, is 
called the Foreign Key. Enforcing referential integrity ensures that the following 
three rules will not be broken:   

• Do not enter a value in the foreign key field of a child table if that value 
doesn’t exist in the primary key of the parent table. 

• Do not delete a record from a parent table if matching records exist in a 
related table.  

• Do not change the value in the primary key field if that record has related 
records in another table. 
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Working with Related Tables 
Go to the tables object in the database window, and open the table that’s 
represented on the “one” side of the relationship. Notice that there are expand 
buttons next to each record as shown below. The Expand button is circled. 

 
When the Expand button is clicked, the related information in the second table is 
shown. When entering data, the fields for the related table can be filled after the 
Expand button is clicked. Such a table is shown below. 
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Editing a relationship 
1) Click the Tools menu item, then select Relationships. OR, click the 

Relationships icon in the toolbar. 
2) Place the TIP of the mouse pointer directly on the line between two field 

lists, and near the halfway point between the field  
3) Right-click the mouse to see a shortcut menu that will include Edit 

Relationship and Delete. OR, double-click on the line between the two field 
lists to go directly to the Edit Relationships dialog box. 

4) Select Edit Relationships. The Edit Relationships dialog box will appear. 
5) Make needed changes in the Edit Relationships dialog box. 

 
 

 
Cascade Update Related Fields: This option requests that Access 
automatically update any foreign key values in the “child” table (the “many” table 
in a one-to-many relationship) if you change a primary key value in a “parent” 
table (the “one” table in a one-to-many relationship). For example, if this option is 
selected, you can change a primary key such as a social security number in the 
primary table (also called the parent table) and Access will update the social 
security (the foreign key) fields for related records in the child table. 
 
Cascade Delete Related Records: This option requests that Access delete child 
rows in the child table when a parent row is deleted. For example, if you remove 
a customer from a database, it’s a good idea to also remove that customer’s 
orders. The customer record will be removed from the parent table, and the 
related orders will be deleted from the child table when this option is selected. 
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Working with Queries 
 
Using the Zoom Box for Easier Viewing: 

1) Start typing in the criteria cell 
2) HOLD the SHIFT key, then press the F2 key at the top of the keyboard to 

see the Zoom box. (Note that font attributes can be changed by clicking the 
Font button.)  

 
Using OR in a Query 
Note that the row below the Criteria row in the query design screen is an “or” row. 
 
The additional rows below are all “or” rows also, even though they’re not labeled 
as such. The “or” rows would be used if we wanted the query to find either OH or 
WV or PA or KY. For this query, type a state abbreviation in the first four “or” 
lines.  

 
 
Using AND in a Query 
To write a query that will show records in which one condition is true AND 
another condition is also true, type two criteria in the Criteria line in different 
columns. For example, to find all students from Ohio who are freshmen, type OH 
in the criteria row in the State column, and type Freshman in the same criteria 
row, but in the Class column, as shown below.  
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Using AND and OR in a Query 
To find records for Freshmen from Ohio OR  students of any rank from KY, WV, 
or PA, type Freshman and OH on the criteria row to find freshmen from Ohio, 
then type the other state abbreviations on the OR lines as shown 
below. The query will return records of 

• students who live in Ohio AND are in the freshman class. 
• students who live in KY, WV, or PA, regardless of class rank. 
• students from Ohio who are freshmen 
• students from three other states regardless of class rank. 

 
 
 
More Query Examples 
Following are some examples of different ways to write criteria. 3 ways to find 
Credits greater than 3 and less than 6: 

 
Additional “or” rows show records which contain OH or WV or PA or KY in the  
state field. 
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To Find all First Names Starting with J: 
 Type “j*” in the criteria row in the First Name column as shown below: 

 
This means “anything that starts with j followed by any other character(s)”. When  
ou press the TAB key to leave that criteria cell, Access changes the criterion to 
“Like j*” as shown below. Query will find names like Jason, Jerry, and June  
 
To Find all First Names Starting with JO: 
Type “jo*” in the criteria line. When you tab out of the criteria cell for First Name,  
Access will change your criterion to Like “jo*” as shown below. This query will 
find  first names that start with the letters “jo”.  
 

Creating and Using a Parameter Query 
In a parameter query the criterion written on the criteria line is actually a prompt 
to the user of the query to type in a criterion. The prompt must be enclosed in 
square brackets (located above and to the left of the ENTER key) on the criteria 
line. When executed, the query will display the prompt, and the user will enter the 
criterion he or she wishes to use.  
 

 
 
When the parameter query is run, the prompt written on the Criteria line will 
display as shown below ; 
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The query will return records in which the field contains the item the user 
entered. When the query is run, the parameter query’s prompt will display, and 
the user will enter what they are searching for. Multiple prompts may be used in a 
parameter query, too, and will show in left-to-right order.  
 

 
 

Using a Calculated Field in a Query 
A query can be used to perform calculations. For instance, if a PAY RATE field is 
included in a table, a query can be used to multiply that pay rate by 1.5 to 
calculate an overtime rate or add two fields together, or multiply one field by 
another field  

1) Click in the next empty field cell in a query grid 
2) Press Shift F2  
3) Type the name of the new field in the query followed by a colon, then 

space then the fields enclosed in square brackets []involved in the 
calculation. Example GrossPay: [hourly rate]*[rate of pay] 

 
This would create a new field in the query called GrossPay.  When you run the 
query, the GrossPay field shows the result of the calculation you created. 
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To Apply a Format to the Calculated Field: 
1) Return to Design view 
2) Click in the calculated field  
3) Click the Properties button 
4) Click on the Format line 
5) Select Currency from the drop-down list 
6) Close the Properties box and run the query 
 

 
 

The Make Table Query 
1) Move to the Queries object in the database window. 
2) Double-click Create Query in Design view. 
3) In the Show Table dialog box, note three tabs at top left for tables, queries, 

or both. Select the tab that contains the tables or queries from which you 
want to make a new table. (If the Show Table dialog box doesn’t appear, 
click the Show Table icon in the menu bar.) 
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4) Double-click each table or query that has fields you want to include in the 
new table. This will place those tables’ field lists in the field list section of 
the query design screen. 

5) Close the Show Table dialog box. 
6) Double-click the fields in the field lists that you want to include in the new 

table. This will add the fields to the Field row in the query design grid. 
7) With the desired fields in the query design grid, click the down-arrow next 

to the Query Type icon 
8) From the drop-down list, select Make Table Query 

 
The Make Table dialog box will appear.  

9) In the Table Name box, enter the name of the table you want to create. 
(Or, if you’re replacing a table, enter the name of the table you want to 
replace) 

10) Select either Current Database or Another Database. Select name and 
location for new table 

 
11) Click OK 
12) Add criteria to the query if desired. 
13) Save the query if desired. 

14) Click the Run button .  
 
A message will appear to tell you how many rows will be pasted into the new 
table. Note that the message warns that the changes can’t be reversed with 
the UNDO command. 
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15) Click Yes if you’re comfortable with the information provided by the 

message. 
 
The query design screen will appear without any extra dialog boxes when the 
Make Table query has created the new table. 
 

16) Move to the Tables object in the database window and examine the new 
table. 

The Append Query 
The append query is used to append the contents of one table to another table.  
 
Using the Append Query: 

1) Select the Queries object in the database window. 
2) Double-click Create Query in Design View 
3) If necessary, click the Show Table icon to display a list of tables in the 

database. 
4) In the Show Table dialog box, select the table you want to APPEND to 

another table. 
5) Close the Show Table dialog box. 
6) Double-click the fields from the selected table that you want to append to 

the other table. Ensure that the column names in the query are arranged in 
the same order as those in the table you’re appending to. 

7) Click the down-arrow next to the Query Type icon . 
8) Select Append Query 
9) In the Append dialog box, use the dropdown arrow on the Table Name line 

to select the table that you want to append records TO. 
10) Click the radio button to select Current Database. 

 
 

11) Click OK to exit the Append dialog box. 
12) Click the Run button to execute the query. 

 
Note the message advising you that you’re about to append X number of 
rows, and that you can’t undo this action. 
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13) If you’re comfortable with the information contained in the message, click 
Yes to append one table to the other. 

 

Importing Tables 
External files such as Excel spreadsheets can be imported into Access to be 
Access tables. 
 

1) Click the button for the Tables object in Access. 
2) Click FILE, GET EXTERNAL DATA,IMPORT 
3) Specify where the file is to be found in the Look In line at the top of the 

dialog box. Specify what TYPE of file you’re importing in the Files of Type 
line at the bottom of the dialog box. 

4) Select the file you wish to import 
5) Click the Import button to start the Import Wizard, shown below.  
6) If importing a spreadsheet, select whether to show the worksheets or the 

named ranges in the spreadsheet by clicking the appropriate “radio 
button” at the top of the dialog box 

7) Click Next. 
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8) Tell the Import Wizard whether the first row of the imported spreadsheet 
contains Column Headings by checking or clearing the First Row 
Contains Column Headings check box. Click Next 

9) Determine whether to store the imported file in a new table or an existing 
table. If you plan to over-write an existing table, select its name from the 
drop-down list.  

10) Click Next 
11) Click a column header in the bottom part of the Import Wizard to see Field 

Options for that field in the top part of the wizard. Make changes in the 
Field Options section of the wizard if needed, then click Next  

12) Set field options for the field which is highlighted in the bottom of the 
dialog box. 

13) Choose whether to let Access add a Primary Key, choose the Primary Key 
yourself, or elect to have no Primary Key, then click Next 

14) Type a name for the table that will be created from the imported 
spreadsheet on the Import to Table line, then click Finish 

 
The newly-created table will appear in the Tables object of the Database window. 

 
 

Create a Form Representing Two Tables Using the 
Forms Wizard 
 

1) Move to the Forms object in the database window. 
2) Double-click Create Form by using Wizard (or, select Create Form by 

using Wizard, then click the Open button) 
 
The Forms Wizard will start as shown below. 
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3) Use the drop-down arrow on the Tables/Queries line at the top left of the 

dialog box to select the table(s) with fields that you want to include in the 
form. Select the fields that you want on the form by double-clicking a field 
name on the left, or by selecting a field on the left, then clicking the single 
right-pointing arrow. To include all fields in the form, click the double right-
pointing arrows. If you want the form to reflect the information in more than 
one table, you must first have established a relationship among the tables, 
such as the One-to-Many To include information from another table, use 
the drop-down arrow on the Tables/Queries line at the top left of the dialog 
box to select additional tables with fields that you want to include in the 
form.  

4) Select the fields from the additional tables in the same manner  
5) Click Next 
6) Decide how you want to view the data on the form by clicking on a table 

name on the left and viewing a preview of the form on the right 
7) Click Next, then choose a layout for the form 
8) Click Next, then choose a style for the form 
9) Click Next, then type a title for the form and ensure that the “Open the form 

to view or enter information” option button is selected 
10) Click Finish  

 

Working with Controls on a Form 
Controls are the graphical objects that you place on a form to perform specific 
functions when you use the form. All controls have properties, or values, 
assigned to them. You can assign other properties to a control, such as size and 
color. A control that is associated with a field in a table or a query is called a 
bound control. A control that is not associated with a field in a table or a query is 
called an unbound control.  
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To Select a Control: 
Click on the control 
 
To Select Multiple Controls: 
1) Click and drag your mouse around the area or “lasso” to encompass the 

controls to be edited. 
Or 
2) Hold down the SHIFT Key and select the first of several controls then click 

to make additional selections 
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To Modify Properties of Individual Controls on a Form: 

1) Switch to Design View if needed 
2) Select the control(s) 
3) Click the Properties button on the toolbar (or right-click to display a menu 

on which you can select Properties) 
4) Click the All tab in the Properties box to see all available options, or click 

the Format tab to see options related only to formatting 

 
 

The Field List 
Clicking the Field List button will reveal the list of fields in the table or tables 
upon which a form is based. When a form is based on more than one table - a 
form with a subform, for instance - the field list displayed will depend on whether 
the form or the subform is selected. 

  

Adding a Field to a Form Using the Field List 
1) Switch to Design View 
2) Click on a field that’s based on the table from which you want to add 

another field  
3) Click the Field List button and note the table name at the top of the Field 

List 
4) Click and drag the field to the desired position on the form 

 

Moving, Aligning and Sizing Controls 
Controls may be moved, resized, and aligned either “manually” or by selecting 
controls and then selecting options from menus. 
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Moving Controls with the Mouse 
A control that has an attached label may be moved in tandem with the label or 
independently, depending on where the mouse is positioned on the control.  
 
To Move a Control and its Label: 

1) Move the mouse pointer over either the control or its attached label. 
Preparing to select controls 

2) Click and HOLD the left mouse button to see an open hand pointer 
 
 
 

 
 

3) While continuing to hold the left mouse button, drag the controls to a new 
location, then release the mouse button 

 

Move a Control and its Attached Label Independently 
 

1) Click the control or the attached label to select both of them. This will 
cause the appearance of the larger handle in the upper left corner of both 
the control and the label, as shown next 

2) Position the mouse pointer over one of the large selection handles. The 
pointer will turn into a hand with a pointing finger 

 
3) Drag the control to its new position 
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Resizing Controls with the Mouse 
Controls can be resized one dimension at a time or two dimensions at a time, 
depending on where the mouse is positioned. 
 

1) To change two dimensions simultaneously 
2) Click a control once to select it 
3) Position the mouse over a corner selection handle so that the mouse 

pointer becomes a two-headed arrow, as shown next 
4) Click and hold the mouse, then drag away from the center or toward the 

center of the control 
 
To Change One Dimension Independently: 

1) Click a control once to select it 
2) Position the mouse over a top, bottom, or side selection handle so that the 

mouse pointer becomes a two-headed arrow 
3) Click and hold the mouse, then drag away from the center or toward the 

center of the control 
 
 

Using a Text Box for a Calculation 
The form below has a credits field that may be used in a calculation. We’ll add a 
text box, then type a formula in the text box. 
 
 

Open a form in design view 
1) If the toolbox isn’t displayed, click the Toolbox icon in the menu bar 
2) Click and release the Text Box tool, then click in the form where the text 

box should be. An unbound text box will be placed on form 

 
3) Click once in the unbound text box (not inthe label) to see a blinking 

insertion point 
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4) Type a formula. Start with the equal sign, then create the formula by 
enclosing field names in square brackets, as shown below 

5) Click in the attached label to see a blinking insertion point, then type a 
label 

 

 
6) Save the form, then view the form in FormView 

 

Changing the Tab Order 
The tab order is the order in which your cursor moves through controls on a form 
when you press the TAB key. The default tab order is the order in which the 
controls are created on the form. Often, the tab order is not optimized after 
several controls have been added. Use the Tab Order dialog box to change the 
order in which controls are selected when the TAB key is pressed. 

 

Using the Tab Order Dialog Box 
1) Open a form in design view 
2) Select View on the menu bar, then select Tab Order 
3) Click the row selector (gray box at left of the field name) to highlight a field 

name in the Tab Order box 
4) Move the field up or down in the Custom Order list by clicking again on 

the row header then holding the mouse button. A thick line will appear at 
the top edge of the selected row whenever the left mouse button is clicked 
and held. 

5) While continuing to hold the left mouse button, move the field name up or 
down in the list to place it in the proper order 

6)  When the fields are ordered as you want, click the OK button 
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Create a Summary Report 
1) Move to the reports object in the database window 
2) Create a report using the wizard  
3) After selecting fields, determine how you want to view the data, and 

selecting a grouping field if desired, the Report Wizard will present the Sort 
Order screen 

4) Click the Summary Options button to see the Summary Options dialog 
box 

 
. 
The Summary Options dialog box shows fields for which the Sum, Avg, Min, and 
Max functions can be applied. Additionally, the Show area of the dialog box 
allows the options of displaying Detail and Summary on the report, or just 
Summary Only. 

Adopted From OhioU 


